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License

Cerato Software License

TELTRONICS, INC. LICENSE AGREEMENT
for Teltronics Cerato® Software and related Products

(1.22.09)

NOTICE: THE FOLLOWING LICENSE TERMS AND CONDITIONS AND SEPARATE LICENSE AGREE-
MENT(S) INCORPORATED HEREIN BY REFERENCE (COLLECTIVELY, “AGREEMENT”) APPLIES TO 
THE SOFTWARE DESCRIBED HEREIN AND FURNISHED TO YOU BY TELTRONICS.

YOU REPRESENT THAT YOU ARE ACTING ON BEHALF OF YOUR EMPLOYER AND ARE AUTHORIZED 
TO ACCEPT THIS AGREEMENT ON ITS BEHALF (SUCH EMPLOYER BEING HEREIN REFERRED TO AS 
“YOU”). YOU AGREE THAT YOU HAVE READ, UNDERSTAND AND SHALL ABIDE BY THIS AGREEMENT 
AND YOU AGREE THAT THIS AGREEMENT IS ENFORECABLE LIKE ANY WRITTEN NEGOTIATED 
AGREEMENT SIGNED BY YOU.

THE SOFTWARE IS NOT SOLD TO YOU, BUT IS THE PROPERTY OF TELTRONICS AND/OR ONE OR 
MORE OTHER THIRD PARTY LICENSORS PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL 
TREATY. ANY USE OF THE SOFTWARE IS GOVERNED BY THIS AGREEMENT. YOU AGREE THAT YOU 
ARE LICENSING THE SOFWARE FOR YOUR END USE ONLY AND NOT FOR RESALE OR REDISTRIBU-
TION.

1. LICENSE. (a) With respect to all software object code, application interfaces, documentation and any 
updates, revisions or modification thereto (“Software”) of Teltronics and/or its vendors or suppliers which may 
be furnished to You by Teltronics hereunder, You accept and agree to abide by all the license terms and con-
ditions set forth herein and any other separate license agreements that are specific to, and included in docu-
ment or shrink wrap form with the shipment of particular Software, or presented in electronic form (including 
click wrap form) during the loading or installation of such Software. In the event of any conflict between the 
license terms and conditions set forth herein and any such separate license agreements specific to any par-
ticular Software, the license agreements specific to such particular Software shall prevail with respect to such 
particular Software. All Software furnished hereunder by shall be licensed only as set forth herein.

(b) Subject to your compliance with this Agreement including the license obligations pursuant to this 
Section 1, and your payment of the applicable license fees, Teltronics grants to You a personal, nontransfera-
ble, nonexclusive and revocable license to use the Software solely with the equipment sold to You by Teltron-
ics or such other equipment as may be authorized by Teltronics to support such use of the Software for your 
own business operation up to the number of concurrent devices and/or ports as may be authorized by Teltron-
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vi Teltronics Software License
ics. You shall not copy the Software except that You are permitted to make one (1) copy of the Software only 
for backup purposes, provided that You shall include on such copy the same copyright notice and proprietary 
marking that appear on the original Software including diskette markings.

(c) You shall (i) not modify, translate, reverse engineer, reverse compile, decompile, recompile, dis-
assemble, port, copy, download or attempt to derive the source code from the Software, and no license to the 
source code is provided herein; (ii) take all actions necessary to satisfy your obligations under these license 
provisions including the issuance of adequate instructions and monitoring of all appropriate personnel within 
your organization to ensure that such personnel satisfy these license obligations; and (iii) promptly return to 
Teltronics any magnetic tape, disc, semiconductor device or other memory device or system and/or documen-
tation, which has been replaced, modified or updated.

(d) The Software and all copies thereof shall at all times remain the sole and exclusive property of 
Teltronics or its third party vendors or suppliers(s), as applicable, and You shall have no title to or interest in 
such Software and copies thereof. You acknowledge that the Software constitutes valuable trade secrets of 
Teltronics and its third party suppliers. You agree to use the Software solely in accordance with license provi-
sions herein and all the terms and conditions of this Agreement and to treat the Software as the confidential 
and proprietary information of Teltronics. If You sell or otherwise dispose of the media on which the Software 
is fixed, such Software must be erased or destroyed before any such sale or disposal so that the Software is 
no longer ascertainable from such media.

(e) If You sell or otherwise transfer or dispose of the equipment which supports the use of the Soft-
ware in your business operation, or if You fail to comply with any of the terms of this Agreement, all of your 
rights hereunder to possess and use the Software and all copies thereof shall immediately terminate and You 
agree to promptly return the Software and all copies thereof to Teltronics.

2. LICENSE FEES. The license fees paid by Licensee are paid in consideration of the rights granted under 
this License.

3. TERM. The Agreement is effective upon your acceptance of its terms as herein provided or any use of the 
Software and shall continue until terminated. You may terminate this Agreement at any time by returning the 
Software and all copies thereof and extracts therefrom to Teltronics. Teltronics may terminate this Agreement 
upon the breach by You of any term of this Agreement, and Teltronics shall have the right to injunctive relief 
enjoining such acts or attempts constituting a breach (in addition to other legal remedies, all of which are non-
exclusive). Upon such termination by Teltronics, You agree to promptly return to Teltronics the Software and 
all copies and extracts thereof. The following provision shall survive any termination of this Agreement: “Lim-
ited Warranty,” “Limitation of Liability,” “911 Emergency Calling Limitations and Obligations,” “Governing Law, 
Venue and Jurisdiction,” “Enforceability,” “No Waiver,” “Export Compliance,” and “Entire Agreement.”

4. LIMITED WARRANTY. (A)THE PROVISIONS OF THIS LIMITED WARRANTY APPLY ONLY TO SOFT-
WARE SUPPLIED DIRECTLY TO YOU BY TELTRONICS. IF YOU HAVE OBTAINED SUCH SOFTWARE 
FROM AN AUTHORIZED DISTRIBUTOR OF TELTRONICS, YOU AGREE THAT THE ONLY WARRANTY 
APPLICABLE TO SUCH SOFTWARE WILL BE THE LIMITED WARRANY, IF ANY, PROVIDED BY SUCH 
AUTHORIZED DISTRIBUTOR AND TELTRONICS SHALL HAVE NO LIABILITY WHATSOEVER WITH 
RESPECT TO ANY SUCH SOFTWARE.
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(B) TELTRONICS DOES NOT WARRANT ANY TELTRONICS-MANUFACTURED SOFTWARE 
WILL BE ERROR FREE. TELTRONICS WARRANTS THAT SUCH SOFTWARE WILL SUBSTANTIALLY 
CONFORM TO TELTRONICS FUNCTIONAL SPECIFICATIONS. IF ANY TELTRONICS-MANUFACTURED 
SOFTWARE DOES NOT SUBSTANTIALLY CONFORM TO SUCH SPECIFICATIONS, TELTRONICS WILL 
USE REASONABLE EFFORTS TO CORRECT SUCH NONCONFORMANCE IF TELTRONICS IS 
PROMPTLY NOTIFIED BY YOU IN WRITING UPON YOUR DISCOVERY OF SUCH NONCONFORMANCE 
AND IN ANY EVENT NO LATER THAN NINETY (90) DAYS FROM THE DATE OF INITIAL SHIPMENT BY 
TELTRONICS OF SUCH SOFTWARE. THIS WARRANTY IS EXCLUSIVE OF DEFECTS CAUSED BY 
PHYSICAL DEFECTS IN THE SOFTWARE MEDIA DUE TO MISHANDLING, OR SOFTWARE FAILURE 
DUE TO OPERATOR ERROR OR INTERFACING SUCH SOFTWARE WITH ANY OTHER PRODUCTS OR 
SYSTEMS NOT APPROVED BY TELTRONICS. 

(C)TELTRONICS MAKES NO REPRESENTATION OR WARRANTY WHATSOEVER WITH 
RESPECT TO ANY THIRD PARTY SOFTWARE SUPPLIED BY TELTRONICS. YOU AGREE THAT TEL-
TRONICS’ SOLE OBLIGATION WITH RESPECT TO SUCH THIRD-PARTY SOFTWARE SHALL BE TO USE 
COMMERCIALLY REASONABLE EFFORTS TO PASS THROUGH TO YOU THE WARRANTIES, IF ANY, 
THAT MAY BE PROVIDED BY THE THIRD-PARTY VENDORS OR SUPPLIERS SUBJECT TO THEIR 
AUTHORIZATION FOR SUCH PASS THROUGH AND SUBJECT TO ANY AND ALL OF THEIR DISCLAIM-
ERS.

(D) NOTWITHSTANDING ANY OTHER PROVISION HEREIN TO THE CONTRARY, YOU AGREE 
THAT THIS LIMITED WARRANTY IS VOID IF ANY SOFTWARE SUPPLIED BY TELTRONICS IS MODI-
FIED, ALTERED OR CHANGED IN ANY WAY BY ANYONE OTHER THAN TELTRONICS OR CONNECTED 
TO OR INTERFACED WITH ANY PRODUCTS OR SYSTEMS NOT APPROVED BY TELTRONICS. TEL-
TRONICS MAKES NO WARRANTIES OR REPRESENTATIONS EXCEPT AS EXPRESSLY SET FORTH IN 
THIS LIMITED WARRANTY.

(E) THIS LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATON, ANY IMPLIED WARRANTY OF MER-
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR ANY WARRANTY OF NON-INFRINGE-
MENT. WITHOUT LIMITING THE FOREGOING, TELTRONICS DOES NOT WARRANT THAT ANY 
SOFTWARE OF ANY KIND WILL BE WITHOUT FAILURE, DELAY, ERROR, BREAKDOWN, OUTAGE, 
INTERRUPTION, DEGRADATION OF VOICE QUALITY OR LOSS OF CONTENT, DATA OR INFORMATION. 
THE REMEDIES PROVIDED UNDER THIS LIMITED WARRANTY ARE YOUR SOLE AND EXCLUSIVE 
REMEDIES. IN THE EVENT THAT SUCH REMEDIES PROVIDED BY THIS AGREEMENT FAIL OF THEIR 
ESSENTIAL PURPOSE, YOUR SOLE AND EXCLUSIVE REMEDY SHALL BE LIMITED TO THE REFUND 
OF WHATEVER PORTION OF LICENSE FEE THAT YOU PAID TO TELTRONICS FOR THE DEFECTIVE 
SOFTWARE COVERED BY THIS LIMITED WARRANTY.

5. LIMITATION OF LIABILITY. IN NO EVENT WILL TELTRONICS BE LIABLE FOR INCIDENTAL, 
INDIRECT, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE DAMAGES OF ANY KIND EVEN IF 
THEY ARE FORESEEN OR FORESEEABLE. TELTRONICS' MAXIMUM CUMULATIVE LIABILITY RELA-
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TIVE TO ALL OTHER CLAIMS AND LIABILITIES, INCLUDING THAT WITH RESPECT TO DIRECT DAM-
AGES, WILL NOT EXCEED THE LICENSE FEE PAID FOR THE SOFTWARE GIVING RISE TO THE CLAIM 
OR LIABILITY. ANY ACTION AGAINST TELTRONICS MUST BE BROUGHT WITHIN EIGHTEEN (18) 
MONTHS AFTER THE CAUSE OF ACTION ACCRUES. THESE DISCLAIMERS AND LIMITATIONS OF LIA-
BILITY WILL APPLY REGARDLESS OF ANY OTHER CONTRARY PROVISION OF THIS AGREEMENT 
AND REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT, TORT OR OTHERWISE, 
AND FURTHER WILL EXTEND TO THE BENEFIT OF TELTRONICS' SUPPLIERS, DISTRIBUTORS AND 
OTHER TELTRONICS’ AUTHORIZED RESELLERS AS THIRD-PARTY BENEFICIARIES. EACH PROVI-
SION IN THE AGREEMENT WHICH PROVIDES FOR A LIMITATION OF LIABILITY, DISCLAIMER OF WAR-
RANTY OR CONDITION OR EXCLUSION OF DAMAGES IS SEVERABLE AND INDEPENDENT OF ANY 
OTHER PROVISION AND IS TO BE ENFORCED AS SUCH.

6. 911 EMERGENCY CALLING LIMITATIONS AND OBLIGATIONS. (a) You, at your cost, shall be responsi-
ble for procuring the supply, implementation, connection and support of any required telephone service 
including emergency 911 call service over the Internet and/or public switched telephone network (“PSTN”) 
from one or more third party service providers as required in conjunction with the use of the software and 
related products by You and other users for voice over internet protocol (“VOIP”) communications.

(b) You are responsible for complying with all laws, rules and regulations applicable to the installation 
and use of the Software and related products (collectively, “Laws”) including without limitation all Laws relating 
to 911 dialing for emergency service.

(c) 911 dialing to an appropriate public safety answering point (“PSAP”) for emergency service is lim-
ited when using a VOIP phone Product co-located with and connected to the switch Product at your enter-
prise location because VOIP telephone service may be interrupted, delayed, lost or terminated due to various 
causes including but not limited to power outage, excessive bandwidth consumption, termination of service 
with or by the network service provider and/ or other T1 provider, product, equipment, software, system and/
or network failures or computer viruses. It is strongly recommended that You make alternative 911 dialing 
available to employees and other individuals at your enterprise via traditional wire line service over the PSTN.

(d) Prior to initiating the use of Teltronics Products in conjunction with any IP network including Inter-
net telephone service for VOIP communications, You shall notify, in writing, each employee and any other per-
son authorized to use the Products for such VOIP communications (individually and collectively “User(s))” of 
the following limitations:

911 DIALING TO AN APPROPRIATE PUBLIC SAFETY ANSWERING POINT (“PSAP”) FOR 
EMERGENCY SERVICE IS NOT AVAILABLE WHEN USING ANY PORTABLE VOIP PHONE PRODUCT AT 
A STREET ADDRESS THAT IS DIFFERENT FROM THE STREET ADDRESS OF THE END USER’S 
ENTERPRISE WITH AN IP NETWORK CONNECTION FROM THAT REMOTE LOCATION TO THE SWITCH 
SERVICING THE END USER’S ENTERPISE. DO NOT USE SUCH PORTABLE VOIP PHONE PRODUCT AT 
THE REMOTE LOCATION TO PLACE 911 EMERGENCY CALLS BECAUSE SUCH PORTABLE VOIP 
PHONE IS NOT CAPABLE OF COMMUNICATING THE STREET ADDRESS OF THE REMOTE LOCATION. 
EMERGENCY 911 CALLS MUST BE PLACED OVER A WIRE LINE PHONE AT THE REMOTE LOCATION 
WHICH IS CONNECTED TO TRADITIONAL PUBLIC SWITCHED TELEPHONE NETWORK (“PSTN”) FOR 
LOCAL SERVICE OR OTHER PHONE THAT IS CAPABLE OF COMMUNICATING THE STREET ADDRESS 
OF THE REMOTE LOCATION TO HELP INSURE THAT SUCH EMERGENCY 911 CALLS ARE ROUTED 
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TO THE APPROPRIATE PSAP OPERATOR RESPONSIBLE FOR RESPONDING TO EMERGENCIES AT 
THE REMOTE LOCATION. USERS MUST WARN ALL INDIVIDUALS AT THE REMOTE LOCATION THAT 
SUCH PORTABLE VOIP PHONE PRODUCT CAN NOT BE USED TO PLACE ANY SUCH EMERGENCY 
911 CALLS FROM THE REMOTE LOCATION BECAUSE OF THIS LIMITATION. USERS MUST INSTRUCT 
ALL INDIVIDUALS AT THE REMOTE LOCATION TO PLACE ANY 911 CALLS FOR EMERGENCY 
RESPONSE TO THE REMOTE LOCATION FROM A WIRE LINE PHONE AT THE REMOTE LOCATION 
WHICH IS CONNECTED TO THE TRADITIONAL PSTN FOR LOCAL SERVICE OR OTHER PHONE THAT 
IS CAPABLE OF COMMUNICATING THE STREET ADDRESS OF THE REMOTE LOCATION TO HELP 
INSURE THAT SUCH EMERGENCY 911 CALLS ARE ROUTED TO THE APPROPRIATE PSAP RESPON-
SIBLE FOR RESPONDING TO EMERGENCIES AT THE REMOTE LOCATION.

(e) If You permit any User to use the VOIP phone Product at a remote location connected to the 
switch at your
enterprise location, it is strongly recommended that You affix a non removable label on the hand set of each 
VOIP phone Product, prior to any such use that displays the following clear and conspicuous warning

DO NOT USE THIS PHONE TO DIAL 911 EMERGENCY SERVICE CALLS UNLESS YOU ARE 
PHYSICALLY LOCATED AT THE FOLLOWING ADDRESS: (INSERT YOUR ENTERPRISE ADDRESS 
WHERE THE PSAP WILL RESPOND TO 911 EMERGENCY CALLS DIALED THROUGH THE SWITCH)

(f) You agree to defend, indemnify and hold harmless Teltronics, its subsidiaries, affiliates and their 
respective officers, directors, employees, distributor, agents and suppliers from any obligations, claims, suits, 
demands, causes of action, losses, liabilities, fines, penalties, damages, costs, or expenses, (including with-
out limitation, attorneys fees), arising on account of any injury or death of persons, or damage to property 
asserted or incurred by or on behalf of any governmental entity, User or any other party arising out of or 
resulting from (i) any of your acts or omissions including without limitation, any failure of You to comply with 
any Laws; or (ii) any use, inability to use, removal, failure, delay, error, breakdown, absence, outage or inter-
ruption of any telephone service including emergency 911 call service over the Internet and/or PSTN or any 
Software or Product including without limitation, any VOIP phone Product.

7. GOVERNING LAW, VENUE, AND JURISDICTION. This Agreement will be governed by and construed in 
accordance with the laws of the State of Florida but without regard to that state’s conflict of laws principles. 
The parties agree that any action to enforce any provision of this Agreement or arising out of or based upon 
this Agreement or the business relationship between Teltronics and You will be brought in the state or Federal 
court of competent jurisdiction in the State of Florida. You and Teltronics agree that the United Nations Con-
vention on Contracts for the International Sale of Goods (1980) shall not apply or govern this Agreement, the 
performance of, or any transaction between the parties under this Agreement. Reasonable attorney fees shall 
be reimbursed, with respect to the foregoing, to the party who prevails on the merits.

8. ENFORCEABILITY. If any provision of this Agreement shall be held to be invalid, illegal or unenforceable, 
the validity, legality or enforceability of the remaining provisions shall in no way be affected or impaired.

9. NO WAIVER. Any non-enforcement of any provision of this Agreement by Teltronics shall not constitute a 
waiver of such provision or prejudice Teltronics right to enforce such provision.
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10. EXPORT COMPLIANCE. The Software and related products, as defined under U.S. export laws, are sub-
ject to U.S. export control laws and regulations and the export of such Software and or related Products is 
conditioned upon receipt of U.S. Government licenses and approvals. You shall ensure that no Software and 
or related Products shall reach any country where U.S. law prohibits the possession or use of such Items. You 
shall comply with all export regulations of the U.S. Department of Commerce and shall not transfer any Soft-
ware and or related Products from the country of delivery, or to any facility engaged in the design, develop-
ment, stockpiling, manufacturing or use of nuclear, missile, chemical or biological weapons, or to any military 
end-user or for a military end-use, without first obtaining Teltronics’ written approval and all required approvals 
of the applicable U.S. agencies. Your obligations hereunder shall survive so long as You possess or control 
the Software and or related Products.

11. ENTIRE AGREEMENT. This Agreement and any written agreement executed by Teltronics and You for 
the supply of the Software and related Products represent the entire agreement between Teltronics and You 
and supersede all prior oral and written communications, agreements, promises, and understandings con-
cerning the Software and related Products. In the event of any conflict between the terms of any written 
agreement executed by You and Teltronics and those of this Agreement, the terms of this Agreement shall 
prevail.

----THIRD PARTY LICENSE AGREEMENTS----

Vovida Software License

The Vovida Software License, Version 1.0
Copyright (c) 2000 Vovida Networks, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the follow-
ing disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

3. The names "VOCAL", "Vovida Open Communication Application Library", and "Vovida Open Communica-
tion Application Library (VOCAL)" must not be used to endorse or promote products derived from this soft-
ware without prior written permission.

For written permission, please contact vocal@vovida.org.
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 Teltronics Software License xi
4. Products derived from this software may not be called "VOCAL", nor may "VOCAL" appear in their name, 
without prior written permission of Vovida Networks, Inc.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUD-
ING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE, TITLE AND NON-INFRINGEMENT ARE DISCLAIMED. IN NO EVENT SHALL 
VOVIDA NETWORKS, INC. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT DAMAGES IN 
EXCESS OF $1,000, NOR FOR ANY INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUEN-
TIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUD-
ING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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1
Introduction to the EAWS

The Teltronics Enhanced Attendant Workstation (EAWS) application is a Windows-based 
version of the Teltronics legacy Attendant Workstation product, a call processing 
workstation that allows you to quickly and efficiently manage multiple incoming/outgoing 
calls in a busy environment. The EAWS has most of the features of a regular phone, in 
addition to many other features that are available with computer-based technology. 

The Enhanced Attendant Workstation carries forward all of the applicable features of the 
legacy Attendant Workstation product that you are familiar with without changing most of 
the keyboard shortcuts/navigation, so you do not have to relearn the product.

In addition, since the EAWS runs as a Windows' application, you can take advantage of 
all the Windows' functionality, such as simultaneously using other applications by 
alternating (Alt/Tab) between the desired application(s) and the EAWS. In addition, you 
can configure the EAWS to automatically maximize and appear on top of any other open 
applications whenever a new call comes in. 

This chapter provides details on logging in/out and gives an overview of how to navigate 
around the EAWS.

For a jump start at using the Enhanced Attendant Workstation, see the following:

• Keyboard Layout Map section on page 1 of Appendix B

• EAWS Quick Reference Card, p/n 610-0000-0802
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EAWS Language

The EAWS can be used in several different languages. The default language is English. 
To view available languages or change to another language, do the following:

1.  Open the Enhanced Attendant Workstation application. The Attendant Login default
dialog appears as illustrated in Figure 1-1. Attendant Login default dialog.

Figure 1-1. Attendant Login default dialog

2.  Click the Language button. The Select Language dialog appears as illustrated in 
Figure 1-2. Select Language dialog.
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Figure 1-2. Select Language dialog

3.  Select the desired language. 

4.  Click OK. The Attendant Login dialog reappears in the selected language. 
The default language is changed to the selected language and the EAWS will open in 
the selected language until it is changed again.
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Logging In/Out of the EAWS

If you do not yet have a username and password, see the System Administrator.

To log in:

1.  Open the Enhanced Attendant Workstation application. The Attendant Login default
dialog appears as illustrated in Figure 1-1. Attendant Login default dialog.

2.  Select your username from the drop-down User Name field.

3.  Enter your password in the Password field. The Status Bar will change to 'Connected 
(IPEC) - IP Address [ip address]’ and the status light will change to green.

4.  Click OK. The Attendant Login dialog closes and the EAWS opens. 

Note  The Configure button is accessible only by the System Administrator for configuring
and maintaining the EAWS.

The first time you open the EAWS, the Directory is automatically downloaded and 
appears in the Directory area of the EAWS. Each subsequent time the EAWS is opened, 
only new records are downloaded. You can also periodically manually update the 
directory during your shift, via the Download Directory option on the Directory menu.

While downloading the Directory, the Enhanced Attendant Workstation opens in the 
Absent mode.

5.  Click the Active button when you are ready to begin processing calls.

DLIC Mode:

When the EAWS has been configured to use the DLIC mode, and if you attempt to log in 
when the EAWS has not had enough time to synchronize with the switch database, a 
message appears (on top of the Attendant Login dialog), as illustrated in Figure 1-3. 
Awclient Not Yet Synchronized with Switch message:
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Figure 1-3. Awclient Not Yet Synchronized with Switch message

If this occurs, wait until the synchronization occurs, then continue with the login process. 
The amount of time for the synchronization to occur will vary depending on the size of the 
Directory in the switch database (anywhere from 1 to 30 minutes). Once the 
synchronization process occurs, this message will not appear again, unless there is a 
major change to the Directory or another switch is added to the Network Directory tables.

To log out:

Log Out when you are finished with your shift for the day. If you only need to temporarily 
suspend incoming calls to take a break, etc., change to the Absent Mode.

1.  Press the Absent key (F3) to stop receiving new calls and finish up with all calls in
queue. The light on the Status Display turns red to indicate the EAWS has entered the
Absent Mode and all new calls are now being rerouted.

2.  Click the Log Out button . The EAWS closes, and the Attendant Login 
dialog redisplays.

3.  Leave the Attendant Login dialog open so you can monitor the current status of the 
network, as indicated on the dialog’s Status Display (i.e., green light - active, red light 
- not available).

Note  Any new calls will be routed first to another active attendant, and if none is
available, will be routed to the Failure Destination that has been configured in the switch,
where the call will hear a prerecorded message.
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Navigating the Main Screen

The Enhanced Attendant Workstation main screen, as illustrated in Figure 1-4. EAWS 
Main Screen, is made up of the following functional areas:
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Figure 1-4. EAWS Main Screen
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Menus

Attendant: 

• Active - changes your mode to Active

• Absent - changes your mode to Absent

• Log out - closes the Attendant Workstation and returns you to the Attendant Login
dialog

• Mute - toggles the sound on or off for the caller only

• Options - opens the Enhanced Attendant Workstation Options dialog

View:

Allows you to view/hide the following areas of the Enhanced Attendant Workstation 
application:

• Customize Toolbars - opens the Customize dialog to toggle on/off toolbars, add
commands and other options

• Display Directory on Top - moves the position of the Directory to above the Call
Queue

• Display Directory on Bottom - moves the position of the Directory to below the Call
Queue

• Show Attendant Notes - a toggle that shows/hides the Attendant Notes Window

• Show Directory Notes -a toggle that shows/hides the Directory Notes Window for
the currently selected record

Call Control:

• Lists all currently available Call Control commands. To see a list of keyboard
shortcuts for each command, move your cursor over its button on the Button
Toolbar. The commands grayed out cannot be used while in the current state

• Dialing - opens a pop-up window dialing keypad for dialing digits with the mouse

• DTMF - opens a pop-up window dialing keypad for dialing DTMF digits
EAWS User Guide



Introduction to the EAWS 1-9
Directory: 

• Add Directory Record - opens the dialog to add a new Directory Record

• Edit Directory Record - opens the dialog of the currently selected Directory Record
for editing. 

• Delete Directory Record - deletes the selected Directory Record. Note that system
records cannot be deleted. Non-Admin users can only delete records they own.

• View Directory Record - opens the record as read-only. 

• Download Directory - Downloads new records in the Directory, if there are new
records

• Export - Allows you to select the file name and the location to export the file to,
which can then be viewed or printed

Tools: 

• Alarms - opens the Cerato Alarms window for viewing, or clearing a list of current
alarms in the Cerato

• Inquire - allows you to check the status of an extension without ringing the
extension

• Identify Busy - allows you to view information about a busy extension

• Speed Dial - opens the Speed Dial List window for adding, editing or deleting speed
dial entries

• Toggle Focus - toggles the focus from the Directory to the Call Queue

• Privacy - turns the Privacy feature on or off for an extension

• Message Lamp - turns the Message Lamp feature on or off for an extension

• Class of Service - (default, Level 1, 2, or 3) - submenu allows you to select (default
or Level 1, 2 or 3) COS for an extension 

• Reminders - allows you to add, cancel and view reminder calls for an extension or
unanswered reminder calls for all extensions

• Hotel - provides various Hotel features (i.e., Checkout is currently available)
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Help: 

• Help - opens the online help system

• Index - opens the online help Index feature

• Search - opens the online help Search feature

• Keyboard Layout - opens a window with keyboard layouts map and Quick
Reference

• About ... - displays the current version number and copyright information of the
Enhanced Attendant Workstation

Button Toolbars

The following Button Toolbars are available in the Enhanced Attendant Workstation:

• Call Control - displays buttons for call control commands (if a command is not
available for the current circumstances, its button will be grayed out or unavailable)

• Attendant State - displays buttons that change your state or log you off the
application

• Directory - displays buttons with Directory functions

• Tools - misc. features of the EAWS

• Help - access to the online help system and keyboard shortcuts map

In addition, the following customization can be done to the toolbars:

• Add a new custom toolbar

• Add or remove buttons from toolbars

• Change how toolbars display

• Hide or show selected toolbars - (Attendant State toolbar cannot be hidden)

Directory 

The Directory is an online 'phone book' that lists all published extensions in the switch, 
along with other information about that extension (including their non-switch based phone 
extensions, such as a cell phone or home phone number). The Directory can be used to 
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quickly look up numbers, add new records, dial an extension, and get other information 
about any extension on the switch.

Note that extension information is available to all Attendants using the Enhanced 
Attendant Workstation. 

The Lookup By: <variable> field - adds the selected field to the left-most column of the 
grid, so you can quickly locate a record by typing in specific field information.

Note that the Directory can be moved to display below the Call Queue area by using the 
Directory option on the View menu.

The EAWS Directory has the following features:

• Add, edit, view or delete a Directory record

• Toggle the Directory into focus

• Inquire about the status of a Directory extension 

• Quickly dial a Directory extension

• Quickly look up a record 

• Customize the way the Directory displays

• Update the Directory

• Print/Preview the Directory

• Export Directory to File

• Clear all records from the Directory

Note that not all available fields in a record display in the grid by default. To view all 
records at a glance, select the View Directory Record option from the Directory menu. 
Although you can add fields individually to the grid by clicking on the Lookup By 
<variable> field and selected the desired field.

Table 2-A lists all available fields in a Directory record:
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Table 2-A.  Directory Record fields

Directory Column Description

icon unused at this time

First Name
Last Name
Middle Name
Extension
Department
Email Address
‘Make Record Visible to All Users’ 
checkbox

Basic identifying info for the record.

Toggles record visibility on/off

Work Phone
Home 
Cell 
Fax 
Voice Mail
Pager
Alt Phone1
Alt Phone2

Work Extension
Other phone numbers if available for 
the record.

Phone numbers for the record will 
display in a numbered list in the 
separate <User> Phone Numbers 
Window located the right of the 
Directory, and can be quickly dialed 
via Ctrl + 0 - 9 (0 = 10).

Address
City
State
Zip
Custom 1
Custom 2

Record's home address.

Area
Location
Dept
Building
Room

Record's work location information.

Notes Any misc. notes about record.
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<User> Phone Numbers Window

The <User> Phone Numbers Window, located to the right of the Directory grid, displays 
all phone numbers for the selected record, in a numbered list, which allows you to quickly 
see and/or dial any phone number. Each row in the window has a number associated with 
it, which you can enter (Ctrl + 0-9) to quickly call that number. 

For example if a record's cell phone is in row #2, pressing Ctrl +2 will enter the number in 
the Active Call Display, pressing Enter will dial the cell phone number.

Note  The <User> Phone Numbers Window cannot be hidden. 

Possible phone entries could be:

• Extension (on the switch)

• Home

• Cell

• Fax 

• Voice mail

• Pager

• Alternate Phone 1 or 2

Directory Notes Window

The Directory Notes Window, located to the right of the Directory grid just below the 
<User> Phone Numbers Window, displays misc notes you have entered for the currently 
selected Directory record.

The Directory Notes Window can be shown/hidden by toggling the Show Directory Notes 
option on the View menu.

Call Queue

The Call Queue area, located either above or below the Directory, depending on how 
options are set on the View menu, is made up of the following sections: 
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• Next Call Queue - shows the next call waiting in queue, and is updated every time a
call is answered. See the Calls Waiting: field on the Status Bar for the total number
of calls waiting in queue.

• Active Call Display - show the call/conference that you are currently connected with

• Recall Queue - shows calls that have been answered but have been put on hold,
parked, returned etc.

Note  All attendants logged in will see the same list of calls in the system that you do in
your Call Queue. Calls that you have answered or placed on hold are visible to you only.

Call Details

Table 2-B lists the call details that are available for each call in the Call Queue:

Table 2-B.  Call Details

Column Header Description

Number in Queue Recall Queue calls only. Calls 
are ordered the way they came 
into the Recall Queue.

Source The name or caller ID of the call 
sent by the switch (unknown if 
not available)
EAWS User Guide



Introduction to the EAWS 1-15
Attendant Notes Window 

The Attendant Notes Window is your online notepad or scratch pad for making notes as 
you work. The Notepad is not associated with any particular call. 

Status The current state of the 
referenced call.

• On Hold
• Conversation
• Ringing
• Busy
• Abandoned – Destination
• Abandoned – Source
• Canceled – Source
• Canceled – Destination
• Attendant Hold – Source
• Attendant Hold –

Destination
• Barged
• Paging
• Wait for Page
• Callback
• Wait for Answer
• Invalid Extension
• Dialing
• Ring - No Answer
• Park Recall
• Camp Recall
• Dialing Timeout

Destination The name and number of the 
destination call.

Table 2-B.  Call Details

Column Header Description
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The contents of the Attendant Notes Window are saved when you log off, and come up 
when you log back in.

Note  The Attendant Notes window can be shown or hidden by using the Show Attendant
Notes toggle on the View menu.

Status Display

The Status Display, located at the bottom of the EAWS, shows status and provides 
access to various features, as follows:

• Attendant Mode - Active or Absent (also indicates Going Active and Going Absent)

• Mute State - Mute (Off = yellow, On = red)

• Connection State - shows whether connected to switch or not

• Alarms - click to bring up the Alarms submenu as follows:

• Alarms - opens the switch’s Alarms dialog

• Clear Alarms - clears current alarms shown on the switch’s Alarms dialog;
Alarms icon = yellow (no alarms) or = red (alarms)

• Re-synchronize Alarms - allows you to re-synchronize alarms

• Calls Waiting - the number of calls waiting in queue if more than one call is waiting
(since the first call appears in the Next Call Queue)

• date and time - current date and time
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Call Queue Procedures

This chapter details in alphabetical order, the procedures used in the Call Queue, the 
area in the EAWS that is used for managing calls.

The Call Queue has additional windows that make managing calls easier, i.e., the Call 
Information Window, and the Attendant Notes Window, which are detailed in Chapter 1.

Note  See the Options section on page 8 for details on using the Options dialog which
allows you to customize some of the EAWS Call Queue features.

Call Queue Features

• Answer

• Barge

• Callback

• Calls in Queue

• Camp (Call Waiting)

• Cancel

• Conference

• Connect

• DTMF

• Execute

• Flash (CAS)
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• Hang Up (Cancel)

• Hold

• Hotel

• Identify Busy

• Inquire

• Make Call

• Messages

• Modes

• Mute

• Page

• Page Park

• Privacy

• Recalls

• Select

• Serial Calls

• Speed Dial

• Split

• Toggle Focus

• Transfer

• Voice Mail
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Answer

When a call comes into the EAWS, it appears in the Next Call Queue with the status of 
New Call. If more than one call comes in, the subsequent calls are indicated by the 
number in the Calls Waiting field on the Status Bar. Calls are answered in the order that 
they come in. The Calls Waiting field is updated when calls are answered.

To answer a call in the Call Queue:

In the Active mode:

1.  Press the Call key, i.e., Enter on the Numeric Keypad, or do one of the following:

• Press Enter on the main keyboard

• Double-click the Next Call Queue

• Click the Call button 

The call will appear in the Active Call Display with the status 'Conversation'.

2.  Start talking to the caller.

Note  If you are on an active call when pressing Call, the active call will be released and
the call in the Next Call Queue answered.
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Barge

The Barge feature is used to allow you to join a conversation that is already in progress. 
Barge is typically used for emergency notification.

To Barge a current conversation:

1.  Dial an extension and receive a Busy signal.

2.  Press the Barge key, i.e., Ctrl + F2, or do one of the following:

• Click the Barge button 

• Select the Barge option on the Call Control menu

• Right-click the Call Queue and select Barge

You are conferenced in the conversation you just barged. 

3.  Begin speaking.
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Callback

When you call an internal extension that is either busy or not answering, you can tag the 
extension so that the system calls you back as soon as the extension is available.

The message 'station callback' appears in the recall area to notify you when the extension 
becomes available. 

To place a callback:

With a call in the Active Call Display:

1.  Dial an extension and hear either busy signal or no answer.

2.  Press the Callback Key, i.e. Ctrl + Down Arrow, or use any of the following options:

• Click the Callback button  

• Select the Callback option on the Call Control menu

• Right-click the Call Queue and select the Callback option

The call is removed from the Active Call Display.

When the extension is available, it is indicated by an entry in the Recall Queue with the 
status of 'Station Callback'.

3.  Double-click on the entry in the Recall Queue to dial it. The call is moved to the Active 
Call Display with the status of 'ringing'.
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Calls in Queue

The next call waiting in queue displays in the Next Call Queue, located above the Active 
Call Display.

The Call Waiting field on the Status Bar displays any additional calls waiting in Queue, 
and is updated when calls are answered.

All calls are answered in the order they came into queue.
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Camp (Call Waiting)

The Camp feature, or Call Waiting, allows you to camp an active call on a busy extension. 
When the line is no longer busy, the extension being camped on will ring.

To use the Camp feature:

With a call in the Active Call Display:

1.  Dial the extension and hear a busy signal.

2.  If desired, press the Split key, i.e. Ctrl + Right Arrow, then ask if the caller would like to 
wait.

3.  Press Release, i.e. (.) Period key on the Numeric Keypad (with numlock on) to Camp-
On the call, or any of the following:

• Press the Call key, i.e. Enter on the Numeric Keypad

• Press the Recall key, i.e. Plus Sign (+) on the Numeric Keypad 

The call is camped on the specified extension and the entry is removed from the Call 
Queue.
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Cancel

See the Hang Up (Cancel) topic.
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Conference

The Conference feature allows you to set up a conference call between two or more 
parties.

To set up a Conference Call between two parties:

1.  With a call in the Active Call Display, and a second call on hold in the Recall Queue:

2.  Press the Conference key, i.e., F2,  to initiate the Conference call, or do one of the 
following:

• Click the Conference button  

• Right-click the Call Queue and select the Conference option

• Select the Conference option on the Call Control menu

You are connected in Conference with the other two parties in a conference call.

The Active Call Display will change to show only one call with the source of 'Conference' 
and a status of 'Conversation'. You can hang up at any time leaving the other two parties 
in conversation. 

To add more parties to a conference:

With an active Conference in the Active Call Display:

1.  Dial the additional extension and wait for an answer. The new party will be added to
the Active Call Display as another call in the Active Call Display. 

2.  Press the Conference key, i.e., F2,  to add the new party to the conference, or do one 
of the following:

• Click the Conference button 

• Right-click the Call Queue and select 'Conference'

• Select the 'Conference' option on the Call Control menu

The new call is added to the Conference. 
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To release the conference from the EAWS:

With an active Conference in the Active Call Display:

1.  Press the Release key, i.e., Period key (.) on the Numeric Keypad (with numlock on),
or do one of the following:

• Press the Call key (Enter key on the Numeric Keypad) 

• Press the Recall key (Plus Sign + on the Numeric Keypad)

• Press the Cancel key (Ctrl + Up Arrow)

You are released from the conference without ending it. 
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Connect

You can connect the active call to a call in the Recall Queue by using the Connect 
feature.

To Connect to the first call in the Recall Queue:

In the Active mode:

1.  With a call in the Active Call Display and a call in the first row of the Recall Queue:

2.  Press the Connect key, i.e., Ctrl + End, or one of the following:

• Click the Connect button 

• Right-click the Call Queue and select the Connect option, then the Connect option
on the submenu

• Select the Connect option from the Call Control menu, then the Connect option on
the submenu

3.  Press any of the following keys to complete the connection:

• Release, i.e., Period (.) key on the Numeric Keypad with numlock on

• Call (Enter on Numeric Keypad)

• Recall (Plus Sign on Numeric Keypad)

• Cancel (Ctrl + Up Arrow)

The active call is connected to the first call in the Recall Queue.

To Connect to a specified call in the Recall Queue:

In the Active mode:

1.  With an active call in the Active Call Display and a call in the Recall Queue:

2.  Press the number of the row of the desired call in the Recall Queue (1 - 8), along with 
the Page Down key, i.e., Ctrl + Select.

3.  Press the End key, i.e., Ctrl + Connect, or one of the following:

• Click the Connect button 
EAWS User Guide



2-12 Call Queue Procedures - Connect
• Right-click the Call Queue and select the Connect option, then the number of the
desired Connect option on the submenu

• Select the Connect option from the Call Control menu, then the number of the
desired Connect option on the submenu

4.  Press any of the following keys, buttons, or menu options to complete the connection:

• Release i.e., Period (.) key on Numeric Keypad with numlock on

• Call (Enter on Numeric Keypad)

• Recall (Plus Sign on Numeric Keypad)

• Cancel (Ctrl + Up Arrow)

The active call is connected to the specified call in the Recall Queue.
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DTMF

You may need to send DTMF digits when on a call, so you can interact with dial up 
pagers and auto attendant systems such as IVRs, etc.

The DTMF Key Pad is used just like a phone when dialing DTMF tones, except '/' is used 
in place of '#'.

To send DTMF digits:

With a call is in the Active Call Display:

1.  Select the DTMF option on the Call Control menu, or do one of the following:

• Right-click the Call Queue and select the DTMF option

• Click the DTMF button  

2.  Enter the desired DTMF digits (0 - 9, / for #, and *) on the pop-up Key Pad.

You will hear a tone for each of the digits you are entering as they are sent.

3.  Press Close. 
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Execute

The Execute command is used for different functions, depending on where the focus is 
located at the time on the EAWS:

Table 2-A.  Execute Command functions

Focus How Execute Functions

a Directory record Dial

the Next Call Queue Call

the Active Call Queue Release

the Recall Queue Select, (1-8), and Recall
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Flash (CAS)

The Centralized Attendant Service (CAS) feature allows users, such as department 
stores, to concentrate attendant services at one location. Remote, unattended switches 
can be placed in branch locations. Using the Flash key (F5), you can connect an 
incoming caller to an extension in a branch switch using a Release Link Trunk.

To use CAS:

In the Active Mode:

1.  Answer the branch switch call that is being routed to you.

2.  Press the Flash key, i.e., F5, to place the caller on hold in the branch switch, or do the 
following:

• Click the Flash button  

3.  Hear dial tone, then enter the telephone number of the caller's desired destination 
party.

4.  Press the Flash key, i.e., F5, if you wish to return to the callers

5.  Hear ringing to the called station, then do one of the following:

• to transfer the call: press the Cancel key, i.e., Ctrl + Right Arrow

• to announce the call, then transfer: wait for answer, announce the call, then press
the Cancel key, i.e., Ctrl + Right Arrow
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Hang Up (Cancel)

To hang up the current call:

With a call in the Active Call Display:

1.  Let the caller know you are ending the call.

2.  Press the Cancel key, i.e., Ctrl + Up Arrow, or do one of the following:

• Click the Cancel button 

• Select the Cancel option on the Call Control menu

• Right-click the Active Call Display and select the Cancel option

The call disconnects and is removed from the Active Call Display.

Note  In addition to hanging up the current call, the Cancel key also does the following:

• Exits the following features: Msg Lamp On/Off, Privacy On/Off, COS, Inquire

• Clears the Active Call Display if a mistake is made while dialing a number
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Hold

To place a call on hold:

With a call in the Active Call Display:

1.  Let the caller know you are placing him or her on hold.

2.  Press the Release Key, i.e., Period (.) on the Numeric Keypad (with numlock on), or 
do one of the following:

• Click the Release button 

• Select the Release option from the Call Control menu

• Press the Enter key, or the Enter key on the Numeric Keypad

The call will be placed on hold and moved to the Recall Queue with the Status of ‘Holding' 
and the call will no longer display to other Attendants.

To place a call on temporary hold:

You may wish to place a call on hold very briefly and then quickly recall it again. If so, use 
the following steps:

With a call in the Active Call Display:

1.  Let the caller know you are placing him or her on hold.

2.  Press the Split key, i.e. Ctrl + Right Arrow.

3.  To quickly recover the held party, press the Split key again.

To retrieve a call on hold:

1.  Click the Recall key, i.e., the Plus Sign on the Numeric Keyboard, or do any of the
following:

• Double-click on the call in the Recall Queue

• Select the Recall option on the Call Control menu
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• Right-click on the Call Queue and select the Recall option, then the number of the
call

The call moves to the Active Call Display with the status of 'Conversation'.

2.  Begin speaking to the caller.
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Hotel

The Hotel feature allows you to perform miscellaneous hotel features from the EAWS. 
The EAWS currently has the following Hotel features available:

• Checkout

• Wakeup Calls - see the Reminders topic

To checkout an extension from the EAWS:

The Checkout feature allows you to checkout a guest’s extension from the EAWS, to 
ensure they won’t be able to make any more calls from that extension.

In the Active mode:

1.  Click the Hotel option on the Tools menu and select Checkout. The Checkout dialog
opens.

2.  Hear Dialtone.

3.  Enter the extension to checkout. The extension is checked out of the EAWS.
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Identify Busy

The Identify Busy feature allows you to view information about a busy extension. The 
following status information appears:

To check the Identity of a Busy Party:

In the Active mode:

1.  Dial an extension and hear a busy signal.

2.  Press the Identify Busy key, i.e., F11, or do the following to display the status 
information in a status window:

• Click the Identify Busy button 
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A dialog opens with details about the busy extension, as illustrated in Figure 2-1. Identify 
Busy.

Figure 2-1. Identify Busy 

3.  Click OK.
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Inquire

The Inquire feature allows you to check the status of an extension without ringing the 
destination.

To Inquire about an extension's status:

In the Active mode:

1.  Press the Inquire key, i.e., F10, or do one of the following:

• Select the Inquire option on the Tools menu

• Click the Inquire button 

The Inquire dialog opens. If you were in conversation, the other party is put on hold.

2.  Dial the extension you wish to inquire about. 

3.  Hear the confirmation tone, followed by dial tone.

A dialog opens to display details about the extension, as illustrated in Figure 2-2. Inquire 
dialog:
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Figure 2-2. Inquire dialog

4.  Click OK.

5.  Do one of the following:

• Repeat steps 2 - 4 to display the status of another extension

• Split key (Ctrl + Right Arrow) - to return to the source party and report the extension
status 
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Make Call

The 0 - 9, /, * keys on the Numeric Keypad are used similar to dialing a phone. Note that 
the '/' key is used in place of the '#' key.

When connecting to a system (such as Voice Messaging) that requires DTMF tones, then 
use DTMF Dialing.

Note  You may need to use an access code such as '9' when dialing outbound calls. See
the System Administrator for details on how your switch is configured to dial outbound
calls.

To make a call:

In the Active mode:

1.  Dial the number on the Dialing Keypad (with numlock on), or do one of the following:

• Double-click on an entry in the Directory

• Click the Dialing button and click the extension's digits 

• Select a record in the Directory and press Dial, i.e., Ctrl + Left Arrow

• Select a record in the Directory then press Ctrl + 0 - 9 for Directory Dial 0 - 9

Note  Press Release key, i.e., Period (.) on the Numeric Keyboard (with numlock on) if
you entered a wrong digit, to reenter.

The number dials while an entry displays in the Active Call Display with the status 
'Ringing'.

2.  Start speaking when the call is answered. The status changes to 'Conversation'.
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Messages

When an extension sets a message on their phone (e.g. out to lunch, or absent), when 
you dial that extension, the message will display on the EAWS Status Display.

To set a message at an extension:

1.  On the extension phone:

2.  Press the Mute/Save button.

3.  Press the MSG button.

4.  Select the desired message and press Mute/Save.

'Action Confirmed' displays and the message appears on the phone's display.

To cancel a message at an extension:

1.  On the extension phone:

2.  Press the Mute/Save button.

3.  Press the MSG button.

4.  Select the 1 Erase option and press Mute/Save.

The message is removed from the phone's display.

Using the Inquire feature to view extension messages:

To view the message set at an extension, use the Inquire feature.
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Modes

The Enhanced Attendant Workstation application has two modes, one of which you will 
be in at any given time while logged in, as follows:

• - Active mode - indicates you are ready to receive incoming calls; gives
you access to all features

• - Absent mode - redirects incoming calls to another attendant or if none
is available, a Failure Destination; allows you to finish up the current call you are on
and still make outgoing calls

The current mode displays on the Status Bar. 

The EAWS opens in the Absent mode.

To change the EAWS mode:

1.  Press the Absent key, i.e., F3, to toggle the mode from Absent to Active, or vice
versa, or do one of the following:

• Click the Absent  or Active button 

• Select the Active or Absent option on the Attendant menu

• Click the Active/Absent icon on the Status Bar and select the desired mode

Note  F3 is a toggle and the menu and toolbar options control the Absent/Active features
separately.

If active, recall or new calls are waiting when you go Absent, the following occurs:

• Status Bar changes to 'Going Absent' until all active calls, recalls and calls waiting
are completed, then will change to Absent

• New calls are redirected to another Attendant, or to the Failure Destination if no
other Attendants are active

• Active/Absent icon on the Status Bar is updated to indicate the new mode
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Mute

When you are on an active call, you can use the Mute feature to toggle the sound on and 
off so the caller won’t be able to hear you, but you will still be able to hear the caller. 

The Status Bar displays the status of the Mute button:

• Mute On - 

• Mute Off - 

To toggle the Mute feature:

With a call in the Active Call Display:

1.  Do one of the following:

• Press Ctrl + M

• Select the Mute option on the Attendant menu

• Click the Mute button on the Attendant Toolbar to toggle it on (red) or off (yellow)

• Click the Mute button on the Status Bar and select Mute to toggle it on (red) or off
(yellow)

Note  Be sure to turn Mute off before attempting to speak to the caller again.
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Page

You can use the Page feature to announce a message company-wide or use it with the 
Page Park feature to park a page at an extension and inform the party.

To make a Page:

There are two types of pages:

• Direct page - used to access the loudspeaker system to make announcements

• Zone page - used to locate a desired party to tell them you have a call parked for
them

To make a Direct Page:

In the Active Mode:

1.  Press the Page key, i.e., Dash (-) on the Numeric Keypad or do one of the following:

• Click the Page button 

• Click the Page option on the Call Control menu and select the desired Page Zone
(1 - 8) option

• Right-click the Call Queue and select the Page option, then select the desired Page
Zone (1-8)

2.  Hear a beep tone indicating that the paging system is available. Note that if the 
paging system is in use, you will receive ringback, and the status message of 'Wait for 
Page' in the Active Call Display. If this happens, wait on the line until you hear the 
beep tone and the status message in the Active Call Display changes to 'Paging'.

3.  Announce your page.

To make a Zone Page:

Up to eight paging zones are allowed for paging, depending on your system 
configuration.

Determine the Park extension for your Attendant Workstation. _____________  You may 
need to check with your System Administrator for the Park extension.
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In the Active Mode:

1.  Press the Select key, i.e., Ctrl + Page Down.

2.  Dial the desired Zone Number (1-8). If you do not select a zone, the zone defaults to 1 
(typically configured for all zones).

3.  Press the Page key, i.e., Dash (-) on the Numeric Keypad, or one of the following:

• Click the Page button  

• Click the Page option on the Call Control menu and select the desired Page Zone
(1 - 8) option

• Right-click the Call Queue and select the Page option, then select the desired Page
Zone (1 - 8) option

4.  Hear a beep tone indicating that the paging system is available. Note that if the 
paging system is in use, you will receive ringback, and the status message of 'Wait for 
Page' in the Active Call Display. If this happens, wait on the line until you hear the 
beep tone and the status message in the Active Call Display changes to 'Paging'.

5.  Announce your page.
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Page Park

After extending a call to a destination that remains unanswered, the call appears in the 
Recall Queue with the status of 'ring - no answer'. After making the call active, you may 
wish to Page the desired party and park the call.

To park a page:

1.  Answer the returned call in the Recall Queue. The call moves to the Active Call
Display with status 'ring - no answer'.

2.  Ask the caller if they would like you to page the desired party.

3.  Press the Page key, i.e., Dash (-) on the Numeric Keypad, or one of the following:

• Click the Page button 

• Click the Page option on the Call Control menu and select the desired Page Zone
(1 - 8) option

• Right-click the Call Queue and select the Page option, then select the desired Page
Zone (1 - 8) option

4.  Hear a beep tone indicating that the paging system is available. Note that if the 
paging system is in use, you will receive ringback, and the status message of 'Wait for 
Page' in the Active Call Display. If this happens, wait on the line until you hear the 
beep tone and the status message in the Active Call Display changes to 'Paging'.

5.  Announce your page.

6.  Press the Release key, i.e., Period (.) on the Numeric Keypad (with numlock on), to 
park the source party on the at the destination extension, or do any of the following:

• Press Call, i.e. Enter on the Numeric Keypad - to simultaneously answer the next
call in queue

• Press Recall, i.e. +, Plus Sign on the Numeric Keypad
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Privacy

The Privacy feature lets you place a workstation in a 'busy out' condition to prevent 
incoming calls from ringing at that extension. 

Outgoing calls and wakeups are unaffected, but incoming calls hear a busy signal.

To turn on Privacy for an extension:

In the Active mode:

1.  Press the Privacy On key (F7), or do one of the following:

• Click the Privacy On button 

• Click the Privacy option on the Tools menu then select the Privacy On option on the
submenu

2.  Hear the confirmation tone, followed by dial tone. The Privacy On dialog opens.

3.  Dial an extension. Privacy is turned on for that extension. 

or

While in conversation with an active call:

4.  Dial the extension. Privacy is turned on for the current extension.

To turn off Privacy for an extension:

In the Active mode:

1.  Press the Privacy key (Ctrl + F7), or do one of the following:

• Click the Privacy Off button 

• Click the Privacy option on the Tools menu then select the Privacy Off option on the
submenu

• Right-click the Call Queue and select the Privacy option then select the Privacy Off
on the submenu

2.  Hear the confirmation tone, followed by dial tone. The Privacy Off dialog opens.
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3.  Dial the extension. Privacy is turned off for that extension.

or

While in conversation with an active call:

4.  Dial the extension. Privacy is turned off for the current extension.
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Recalls

A recall is any call that you originally extended that went unanswered, so is returned to 
you to the Recall Queue for further handling. In addition recalls can be calls placed on 
hold or serial calls. The Recall Queue holds up to eight calls.

To extend a call and simultaneously answer the first recall:

In the Active mode:

1.  Press the Recall key, i.e., Plus Sign (+) on the Numeric Keypad, to answer the first
call in the Recall Queue, or do one of the following:

• Select the Recall option on the Call Control menu, then the Recall option on the
submenu

• Right-click the Call Control menu and select the Recall option, then the Recall
option on the submenu

• Click the Recall button  

The call moves to the Active Call Display.

2.  If needed, press the Recall key again to re-extend the call and automatically answer 
the next call in the Recall Queue

Note  If you are in conversation and when you press the Recall key, the active call is
automatically extended (placed on hold) and the first recall is brought to the Active Call
Display into conversation.

To answer other than the first recall:

In the Active mode:

1.  With a call in the Active Call Display:

2.  Press the Select key, i.e., Ctrl + Page Down.

3.  Dial the Recall Queue number (1 - 8).

4.  Press the Recall key, i.e. Plus Sign on the Numeric keypad, to extend the call and 
simultaneously answer the designated call in the Recall Queue. 
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Select

The Select key allows you to select a specific call from the Recall Queue for further 
processing: as follows:

1.  Press Select, i.e., Ctrl + Page Down, on the Numeric Keypad.

2.  Press the number of the call you wish to select in the Recall Queue on the Numeric 
Keypad (1 - 8).

3.  Press Recall, Connect or Page, as desired.
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Serial Calls

Prior to extending an active call to an internal destination, you can tag the call for return to 
the EAWS for further handling. Then when the caller's conversation terminates, the call 
enters the Recall Queue with the status 'serial'.

The Serial key is useful when handling callers who wish to reach multiple destinations.

To extend a serial call:

In the Active Mode:

1.  Answer the incoming call. The call displays in the Active Call Display.

2.  Tag the call for serial return while in conversation by pressing the Serial key, i.e., Ctrl 
+ Delete, or do one of the following:

• Click the Serial button  

• Click the Serial option on the Call Control menu

• Right-click the Call Queue and select the Serial option

3.  Inform the caller that they will return to you for further processing provided they do not 
hang up after completing their call.

4.  Dial the desired extension.

5.  Press the Release, Call or Recall key to complete the serial call. The Active Call 
Display clears. 

The call continues to be tagged as a serial call until the source party hangs up, and, when 
the source party completes their conversation, the call returns to the Recall Queue for 
further handling.

Retrieve the call to the Active Call Display and repeat Steps 3 - 5 for other calls the 
source party wishes to make.
EAWS User Guide



2-36 Call Queue Procedures - Speed Dial
Speed Dial

The Speed Dial feature allows you to add, view, edit or remove numbers in the Speed 
Dial List and/or quickly dial any number in the list.

To open the Speed Dial List:

Figure 2-3. Speed Dial List dialog

1.  Click Ctrl + S or do one of the following:

• Click the Speed Dial button 

• Select the 'Speed Dial List' option on the Tools menu

The Speed Dial List dialog opens as illustrated in Figure 2-3. Speed Dial List dialog.

Note  If desired, you can keep the Speed Dial List dialog open and click the title bar to
drag it out of the way.
EAWS User Guide



Call Queue Procedures - Speed Dial 2-37
Configuring the Speed Dial List:

The Speed Dial List dialog can be used to do the following configuration:

• Add a new speed dial entry

• Edit a speed dial entry

• Delete speed dial list entries

• Clear all speed dial entries

Note  To make a call, use the shortcut keys for the entry you wish to dial.

The Speed Dial List dialog consists of the following columns:

To Add a speed dial number:

1.  Click the 'Add Speed Dial' option on the Edit menu to open the 'Add Speed Dial'
dialog, as illustrated in Figure 2-4. Add Speed Dial dialog.

Table 2-B.  Speed Dial List dialog

Column Description

Key (Alt + 0 - 9) the keyboard shortcut combination 
for the speed dial number

Description an identifying description of the 
speed dial number

Number the speed dial extension
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Figure 2-4. Add Speed Dial dialog

2.  Enter the description of the speed dial number in the 'Description' field.

3.  Enter the speed dial extension in the 'Number' field.

4.  Select the desired keyboard shortcut from the 'Key ' drop-down list, or use the default 
assigned.

5.  Click Add. The entry is added to the list.

6.  Click Save.

7.  Click Close.

To Edit a speed dial number:

1.  Click the 'Edit Speed Dial' option on the Edit menu to open the 'Edit Speed Dial'
dialog, as illustrated in Figure 2-5. Edit Speed Dial list dialog.
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Figure 2-5. Edit Speed Dial list dialog

2.  If needed, enter a new description of the speed dial number in the 'Description' field.

3.  If needed, enter a new speed dial extension in the 'Number' field.

4.  If needed, select the desired keyboard shortcut from the 'Key ' drop-down list, or use 
the default assigned.

5.  Click OK. The revised entry appears in the list.

6.  Click Save.

7.  Click Close.

To Delete a speed dial number:

1.  Select the row of the Speed Dial entry you wish to delete.

2.  Click the 'Delete Speed Dial' option on the Edit menu to open the Delete Speed Dial 
dialog, as illustrated in Figure 2-6. Delete Speed Dial dialog.
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Figure 2-6. Delete Speed Dial dialog

3.  Click Delete.

4.  Click Save.

5.  Click Close.

To Clear all speed dial numbers:

1.  Click the 'Clear all Speed Dials' option on the Edit menu to open the Clear? dialog, as
illustrated in Figure 2-7. Clear? dialog.

Figure 2-7. Clear? dialog
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2.  Click Yes. All Speed Dial entries are removed.

3.  Click Save.

4.  Click Close.

Making a Speed Dial call:

1.  Enter Alt + 0 - 9 of the speed dial entry you wish to dial.

Note  You may need to open the Speed Dial List to see what the shortcut assignments
are.

The call appears in the Active Call Display and the number is dialed.
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Split

The Split key is also used to place the active call on temporary hold.

In addition, if you have two active calls, the Split key allows you to alternate between 
conversation with the source party and the caller's destination party. The party that 
appears highlighted in the Active Call Display is the conversation party, while the party 
not currently in conversation remains on hold. 

To use the Split feature:

With an active call:

1.  Press Split, i.e., Ctrl + Right Arrow, on the Numeric Keypad, or do the following:

• Click the Split button 

The call is placed on temporary hold in the Recall Queue.

2.  Press Split again to answer the call on temporary hold.

With two active calls:

1.  Press Split, i.e., Ctrl + Right Arrow, on the Numeric Keypad, to place toggle between
the active call and call on hold, or do the following:

• Click the Split button 
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Toggle Focus

Before using the Directory or Call Queue, you will need to bring it into focus. The 
exception is when new calls come in. If you have focus on the Directory when a new call 
comes in, pressing Enter, or Call on the keyboard, automatically toggles the focus to the 
call Queue and answers the new call.

To Bring the Directory/Call Queue into Focus:

• Click anywhere on the Directory/Call Queue with your mouse

• Press F12 to toggle back and forth from the Call Queue to the Directory

• Click the Toggle Focus button
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Transfer

There are two ways you can extend or transfer calls: (also, see the Voice Mail topic)

• Unsupervised Transfer - transfers the call without announcing it first

• Supervised Transfer - allows you to announce the call before transferring it

To make an Unsupervised Transfer:

With a call in the Active Call Display:

1.  Dial an extension.

2.  Press Release, i.e., Period (.) key on Numeric Keypad (with numlock on) to complete 
the transfer or do one of the following:

• To transfer the call and simultaneously answer the next call in queue: Press the
Call key, i.e., Enter on the Numeric Keypad

• To transfer the call and simultaneously answer a call from the Recall Queue:  Press
the Recall key, i.e., Plus Sign on the Numeric Keypad

The call is transferred and removed from the Active Call Display.

To Make a Supervised Transfer 

With a call in the Active Call Display:

1.  Dial an extension.

2.  Wait for the party to answer and announce the call.

3.  To return to the original caller, press the Split key, i.e., Ctrl + Right Arrow.

4.  Press Release, Period (.) on Numeric Keypad (with numlock on) to complete the 
transfer or do one of the following:

• To transfer the call and simultaneously answer the next call in queue: Press the
Call key, i.e., Enter on the Numeric Keypad 

• To transfer the call and simultaneously answer a call from the Recall Queue: Press
the Recall key, i.e., Plus Sign on the Numeric Keypad
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Voice Mail

There are two ways to leave a voice mail:

• Leave a voice mail yourself

• Send an active call to voice mail

To leave a voice mail:

With a call in the Active Call Display:

1.  Press the Voice Mail key, i.e., F9, or do one of the following:

• Select the Voice Mail option on the Call Control menu

• Right-click the Call Queue and select the Voice Mail option

• Click the Voice Mail button 

2.  Wait for a recorded message announcing the voice messaging system, then dial the 
person's extension.

3.  Follow the system prompts and leave a voice message.

4.  Press the Cancel key, i.e., Ctrl + Up Arrow, when finished.

To send an active call to voice mail:

If a caller wishes to leave a voice mail for an extension that does not answer, do the 
following:

1.  Retrieve the call from the Recall Queue into the Active Call Display:

2.  Press the Voice Mail key, i.e., F9, or do one of the following:

• Select the Voice Mail option on the Call Control menu

• Right-click the Call Queue and select the Voice Mail option

• Click the Voice Mail button 

The Destination field for the call is replaced with a Cerato circuit.

3.  Dial the requested extension and press the Release key, i.e., Period (.) on the 
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Numeric Keypad (with numlock on).

The caller hears the recorded message, then leaves a message.
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Directory Procedures

This chapter details in alphabetical order, the procedures to use and customize the 
Enhanced Attendant Workstation Directory, as follows:

The Directory is an online 'phone book' and lists all published extensions in the switch, 
along with other information about that extension (including their non-switch based phone 
extensions, such as a cell phone or home phone numbers). You can add new records to 
Directory as needed.

The first time you log into the Enhanced Attendant Workstation, the Directory is 
automatically downloaded. Each subsequent time you log into the EAWS, any records 
that have been added since your last log in will be downloaded. You can periodically 
update the Directory during your shift.

The following directory features are available:

• Add, View, Edit, Delete Directory Record

• Customize Directory

• Inquire

• Lookup a Record

• Dial a Directory Extension

• Export Directory

• Print, Preview Directory

• Toggle Focus

• Update Directory
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• Clear Directory
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Add, View, Edit, Delete Directory Record

To add a new Directory record:

1.  Do one of the following:

• Right-click on the Directory and select the 'Add Directory Record' option

• Click the 'Add Directory Record' button 

• Select the 'Add Directory Record' option on the Directory menu

The Directory Information dialog opens. 

Configuring the Directory Information dialog:

Note  The fields in this dialog will be grayed out/read-only when opened with the View
Directory Record option.

To configure the Directory Information dialog:

1.  Enter the record's first name in the First Name field. If editing a switch record, this field
cannot be changed.

2.  Enter the record's last name in the Last Name field. If editing a switch record, this field 
cannot be changed.

3.  Enter the record's middle name in the Middle Name field. If editing a switch record, 
this field cannot be changed.

4.  Enter the record's extension in the Extension field only if the call is not a switch 
record. If the call is a switch record, this field will be grayed out. Only the Switch 
System Administrator can enter new switch extensions.

5.  Enter the record's department at work in the Department field. If editing a switch 
record, this field cannot be changed.

6.  Enter the record's work email address in the Email Address field.

7.  Remove the checkmark from the 'Make Record Visible to All Users' checkbox to hide 
the record from everyone other than yourself and those with Admin privileges. The 
default setting for the field is ‘checked’. When this field is checked, only yourself and 
those with Admin privileges can make changes to the record.
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To configure the dialog's tabs:

1.  Click the Phone Numbers tab:

2.  Enter the record's work phone number in the Work Phone field.

3.  Enter the record's home phone number in the Home Phone field.

4.  Enter the record's cell phone number in the Cell field.

5.  Enter the record's fax number in the Fax field.

6.  Enter the record's voice mail number in the Voice Mail field.

7.  Enter the record's pager in the Pager field.

8.  Enter the record's first alternate phone number in the Alternate Phone 1 field.

9.  Enter the record's second alternate phone number in the Alternate Phone 2 field.

10.  Click the Address tab:

11.  Enter the record's street number in the Address field.

12.  Enter the record's city in the City field.

13.  Enter the record's state in the State field.

14.  Enter the record's zip code in the Zip field.

15.  Enter the record's first misc. info in the Custom 1 field.

16.  Enter the record's second misc. info in the Custom 2 field.

17.  Click the Location tab:

18.  Enter the record's work area info in the Area field.

19.  Enter the record's work location info in the Location field. If editing a switch record, 
this field cannot be changed.

20.  Enter the record's work building number or name in the Building field.

21.  Enter the record's work room number or name in the Room field.

22.  Enter any misc. notes you wish to keep on file for the call in the Notes window.

23.  Click Save.
EAWS User Guide



Directory Procedures - Add, View, Edit, Delete Directory Record 3-5
Note  The type of record, switch or user, is shown on the bottom left corner of the dialog.

When you return to the main screen, the new Directory record will display.

To edit an existing Directory record:

The Edit option is available for all records.

1.  Select the Directory record you wish to edit.

• Do one of the following:

• Right-click on the Directory and select the 'Edit Directory Record' option

• Click the 'Edit Directory Record' button 

• Select the 'Edit Directory Record' option on the Directory menu

The Directory Information dialog opens. 

2.  See the Configuring the Directory Information dialog: section  above to configure the 
dialog.

When you return to the main screen, the revised Directory record will display.

To view an existing Directory record:

This option allows you to open any record in the read-only mode.

1.  Select the Directory record you wish to view.

2.  Do one of the following:

• Right-click on the Directory and select the 'View Directory Record' option

• Click the ‘View Directory Record’ button 

• Select the 'View Directory Record' option from the Directory menu

The Directory Information dialog opens in read-only format. You cannot make changes 
with this dialog.
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To delete a Directory record:

If you did not create the selected record, the Delete option will be grayed out. Only the 
Attendant who created the record or a System Administrator can delete the record.

1.  Select the Directory record you wish to delete.

2.  Do one of the following:

• Right-click on the Directory and select the 'Delete Directory Record' option

• Click the 'Delete Directory Record' button 

• Select the 'Delete Directory Record' option on the Directory menu

The record is removed from the Directory.
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Customize Directory

To help you quickly get information about an extension, the Directory can be customized 
as follows:

• Adding/removing columns to the grid

• Rearrange columns in the Directory

• Using Filters in the Directory

• Sorting Directory columns

Figure 3-1.  EAWS Directory

Adding/removing columns to the grid:

The Directory grid by default shows only some of its fields in the grid. To view the 
complete record, select the View Directory Record option from the Directory menu. To 
add an additional field to the grid, select the Lookup By <field name> and select the 
desired field name from the list.

1.  Click on a column header with your cursor and move it to the desired location.

Rearrange columns in the Directory:

1.  Click on a column header with your cursor and move it to the desired location.
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Using Filters in the Directory

The Directory Filters feature can help you locate a specific record by rearranging the 
Directory records. The following Filters are available in the Directory:

• Grid Filters - locates the record meeting specific criteria

• Preview - used to look at an entire record at a glance

• Group Panel - used to group records together by a field (e.g. by Department)

To use the Grid Filters:

You can add additional columns to the Directory grid to filter on by clicking on the Lookup 
By: arrow and selecting the desired column. The column appears in the left-most side of 
the grid.

1.  Click the Filter Arrow in the column header you wish to find a record for to open the
filter options and select a filter option from the list: 

• All: (default) - shows all records 

• Custom: opens Custom AutoFilter dialog for that header for you to enter the specific
data you are trying to locate a record for

Figure 3-2.  Custom Auto Filter dialog
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• (Blanks) - shows only records with no entry in the selected header

• (Non Blanks) - shows only records with entries in the selected header 

• ...Specific entries... - lists out all unique entries for that header

The grid will re-display with the filter you have selected, which is indicated on the Filter 
Reminder  at the bottom of the Directory (a text description 
of what filter is currently set)

Note  To quickly remove the filter, click the Clear Filter icon  to the left of the Filter
Reminder at the bottom of the Directory. 

Sorting Directory Columns

To sort columns in the Directory:

1.  Click on a Directory column header to select it. The Sort Arrow  will display to the
left of the Filter Arrow .

2.  Click on the Sort Arrow to toggle it up or down. The listings in the Directory will 
sort by Ascending (Up Arrow) or Descending (Down Arrow) order.
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Inquire

The Inquire feature allows you to check the status of an extension without ringing the 
destination.

To Inquire about an extension's status:

In the Active mode:

1.  Press the Inquire key, i.e., F10, or do one of the following:

• Select the Inquire option on the Tools menu

• Click the Inquire button 

The Inquire dialog opens. If you were in conversation, the other party is put on hold.

2.  Dial the extension you wish to inquire about. 

3.  Hear the confirmation tone, followed by dial tone.

A dialog opens to display details about the extension:
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Lookup a Record

You can quickly select a record by searching for characters that match the characters in 
the left-most field of the Directory grid.

To quickly look up a record:

1.  Do one of the following:

• Use the drop-down Lookup By: <field name> filter to select a field, then enter
characters in the adjacent empty field

• Drag an existing column in the grid by its column title to the location of the first, then
type characters in the adjacent empty field. 

The record that most closely matches those characters will display and be selected in the 
grid.
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2.  Click OK.

3.  Do one of the following:

• Repeat steps 2 - 4 to display the status of another extension

• Split key (Ctrl + Right Arrow) - to return to the source party and report the extension
status 
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Dial a Directory Extension

To quickly dial an extension for a record in the Directory:

1.  Double-click on the Directory extension or do one of the following:

• Select the record in the Directory, then click Ctrl + 0 - 9 to dial the corresponding
extensions listed in the <User> Phone Numbers' Window

• Select the record in the Directory and press the Dial key, i.e., Ctrl + Left Arrow

• Select the record in the Directory and click the Dial Directory button 

The entry moves to the Active Call Display and the extension is dialed.

Specific Number Dialing

The following numbers are used with the Ctrl key to quickly dial the referenced number for 
the selected record:

Ctrl + [key] type of number dialed

0 the extension

1 cell phone

2 pager

3 work phone

4 home phone

5 voice mail

6 fax 

7 Alt Phone 1

8 Alt Phone 2

9 not currently used
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Export Directory

The Export feature allows you to save the Directory to a specified file and location. You 
can then preview or print the file when needed.

To export a file:

1.  Click the Absent button and finish up calls.

2.  Click the Export option on the Directory menu or do one of the following:

• Click the Export button  

• Right-click the Directory and select the Export option

The 'Save As' window opens as illustrated in Figure 3-3. Save As dialog.

Figure 3-3.  Save As dialog

3.  .Enter a name for the file and browse to the desired directory location, then click OK. 
The file is saved to the named .txt file. 

4.  Open the file to preview or print out the Directory, if desired.
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Print, Preview Directory

You can easily print or preview the Directory from the Export feature. See the Export 
Directory feature for details.
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Toggle Focus

Before using the Directory or Call Queue, you will need to bring it into focus. The 
exception is when new calls come in. If you have focus on the Directory when a new call 
comes in, pressing Enter, or Call on the keyboard, automatically toggles the focus to the 
call Queue and answers the new call.

To Bring the Directory/Call Queue into Focus:

• Click anywhere on the Directory/Call Queue with your mouse

• Press F12 to toggle back and forth from the Call Queue to the Directory

• Click the Toggle Focus button
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Update Directory

The first time you log into the Enhanced Attendant Workstation, the Directory is 
automatically downloaded. Each subsequent time you log into the EAWS, any records 
that have been added since your last log in will be automatically downloaded. You can 
periodically manually update the Directory if desired. For example, the System 
Administrator may request that Attendants update their Directories or you may have been 
working a long shift and wish to see the most current records without logging out and 
back into the EAWS.

To update your Directory:

• Select the Directory Download option on the Directory menu

or

• Log out and log back into the EAWS
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Clear Directory

The Clear Directory feature (accessed from the Clear Directory tab on the Attendant 
Workstation Options dialog via the File menu) can only be accessed by users with Admin 
rights. It is used to clear out the switch, user-entries or both switch and user type entries 
in the Directory. 

If the buttons on the Directory are grayed out, you do not have Admin rights, and will need 
to see your System Administrator to clear the Directory.
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Miscellaneous Procedures

This chapter details miscellaneous features of the Enhanced Attendant Workstation, as 
follows:

• Alarms

• COS

• Failure Destination

• Hotel

• Message Lamp

• Options

• Reminders

• Volume

• Wakeup Calls
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Alarms

The Teltronics switch has an alarms feature that lets you know when and where there are 
active problems in the switch, so you can inform the system administrator. The Enhanced 
Attendant Workstation gets alarms information upon startup and as new alarms occur. 

The alarms on/off icon on the Status Display indicates the status of switch’s alarms:

• alarms off 

• alarms on 

Note  You will need to open the switch’s Alarms dialog, as illustrated in Figure 4-1. Switch
Alarms dialog, to do some of the functions described in this topic.

Figure 4-1. Switch Alarms dialog

To open the switch’s Alarms dialog:

1.  Click the Alarms icon on the Status Bar and select the Alarms option to open the
switch’s Alarms dialog, or do one of the following:

• Select the Alarms option on the Tools menu
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• Press F4

• Click the Alarms button 

The following functions are available with the Alarms feature:

• New alarms notification

• View current alarm details

• Clear system alarms

New Alarms notification:

When new alarms occur in the switch, the Alarms icon on the Status Bar will change from 
yellow to red. You can view details about the alarms as described in this topic.

To view current alarm details:

The main window of the switch’s Alarms dialog displays the following information about 
alarms:

• Severity - of alarm (i.e., Major, Minor, Info, Critical)

• Time - time the alarm was triggered

• Type - indicates where the alarm originated

• Category - indicates where the alarm originated for the type specified in the Type
column

• Alarm - indicates the actual problem

When an alarm is activated, notify the System Administrator.

To clear all alarms:

To clear all alarms from the Enhanced Attendant Workstation, do one of the following:

• Press the Clear All button on the switch’s Alarms dialog

• Click the Alarms icon on the Status Display and select the Clear Alarms option
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COS

The Class of Service (COS) feature allows you to change an extension’s COS to one of 
four levels that have been configured in the switch (default and three system-wide COS).

To change COS for an extension:

Note  If you are already in conversation, the COS changes automatically without having
to enter an extension.

1.  Select the desired COS from the Tools menu, i.e., default, Level 1, 2 or 3. The Level X
Class of Service dialog opens, as illustrated in Figure 4-2. Level 2 class of service
dialog. 

Figure 4-2. Level 2 class of service dialog

2.  Enter the extension to assign the COS to on the Extension dialog.

You can view the changed COS for the extension with the Identify (F11) or Inquire (F10) 
feature keys.
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Failure Destination

The failure destination is a number that has been configured by the System Administrator 
where calls will be sent to when you go into the Absent mode or log out of the Enhanced 
Attendant Workstation, and no other Attendant is available to redirect the calls to.
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Hotel

For help using the Hotel feature, see the Hotel section on page 2-19. 
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Message Lamp

You can turn on/off any station's Message Lamp as needed. For example, you may take a 
message for a user and turn their Message Lamp on to let them know to call you to get 
the message. In another scenario, a station's Message Lamp may get stuck on, and the 
individual could call you and request that you turn it off for them, in lieu of trying to reach a 
busy System Administrator.

To toggle the Message Lamp:

In the Active mode:

1.  Press the Msg Lamp On key, i.e., F8, or the Msg Lamp Off key, i.e., Ctrl + F8, or do
one of the following:

2.  Select the Message Lamp option on the Tools menu and select the Msg Lamp: On/Off 
option

3.  Click the Msg Lamp: On  /Msg Lamp: Off  button

4.  Hear the confirmation tone, followed by dial tone. The Message Lamp On/Message 
Lamp Off dialog opens.

5.  Dial the extension for which you wish to turn on/off the Message Lamp for (0-9, /, *).

or

While in conversation:

1.  Click the Msg Lamp: On/Off button.

The Message Lamp for the specified station turns on/off for the specified or current 
extension.
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Options

The Enhanced Attendant Workstation Options dialog allows you to customize and 
configure miscellaneous features and options of the Enhanced Attendant Workstation.

To open the EAWS Options dialog:

1.  Click on the Options item on the Attendant menu or do the following:

• Click the Options button 

The Attendant Workstation Options dialog opens as illustrated in Figure 4-3. AW Options 
dialog - Attendant Settings tab.
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Figure 4-3. AW Options dialog - Attendant Settings tab

To configure the Attendant Settings tab:

1.  Select the Attendant Settings tab.

2.  Automatic Directory Focus:   the Directory takes focus as described by the selected 
option:
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• none

• on new call 

• on answer call

3.  Bring EAWS to front on new call arrival: will pop open the EAWS in front of any other 
open applications when a new call comes in

4.  Reset Configuration to Defaults: a button that changes all settings to the default 
configuration. For example, you might want to clear out the list of previous dialed 
numbers, or the position and size of all the forms, etc.

5.  Change Password: You can change your Login Password by entering a new Password 
in the 'New Password' field and again in the 'Verify Password' field, then clicking the 
Change Password button.

6.  Click Save.
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To configure the Audio Controls tab:

Figure 4-4. AW Options dialog - Audio Controls tab

1.  Select the Audio Controls tab, to display Figure 4-4. AW Options dialog - Audio
Controls tab.

2.  Slide the volume to the desired level for the Attendant headset or speakers.
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3.  Select the desired phone audio device for the headset microphone and PC speakers 
from the lists.

4.  Enter a checkmark in the ‘Play Sound on Call arrival’ checkbox if you wish to be 
notified every time a new call arrives.

5.  Enter a checkmark in the ‘Play Sound on Recall arrival’ checkbox if you wish to be 
notified every time a recalled call arrives.

6.  If a checkmark is in the previous field, select the radio button of the type of sound you 
wish to hear played:

• system beep - select a system sound from the drop-down field

• wav file - browse to the location of the desired wav file 

Note  Wav files selected will play continuously until the call is answered or terminated.
Wav files that emulate the rings on the ClearCom and CIP210 phones, i.e.,
single_ring.wav, double_ring.wav, triple_ring.wav, can be selected. They are installed
by default at the following location: c:\Program Files\Teltronics\Enhanced Attendant
Workstation.

7.  Click Save.
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To configure the Call Activity Log tab:

The Call Activity Log is used by Teltronics Technical Support to assist in troubleshooting 
problems in the EAWS. 

Figure 4-5. AW Options dialog - Call Activity Log tab

1.  Select the Call Activity Log tab, to display the Figure 4-5. AW Options dialog - Call
Activity Log tab.
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2.  Leave the two checkboxes unchecked unless directed to do otherwise by Teltronics 
Technical Support.

To configure the Clear Directory tab:

The Clear Directory tab can only be used by users with Admin rights. It is used to clear 
out the switch, user-entries or both switch and user type entries in the Directory. If the 
buttons on the Directory are grayed out, you do not have Admin rights, and will need to 
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see your System Administrator to clear the Directory.

Figure 4-6. AW Options dialog - Clear Directory tab
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Reminders

The Reminder feature allows you to add, cancel and view reminder calls for an extension 
or unanswered reminder calls for all extensions. 

Note  Teltronics uses the term ‘Reminders’ in the EAWS application, which is
synonymous with the term ‘Wakeup Calls’ which is what is used in the Hotel industry. 

To set up a time reminder call:

1.  Select the Reminder option on the Tools menu, and select the Add Reminder option to
open the Set Reminder dialog, as illustrated in Figure 4-7. Set Reminder dialog.

Figure 4-7. Set Reminder dialog

2.  Hear dial tone.

3.  Enter the extension to set the reminder for in the Extension field. Note that if you are 
already in conversation with the extension, you will not be prompted for the extension.

The Select Reminder Time dialog opens as illustrated in Figure 4-8. Select Reminder 
Time dialog.
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Figure 4-8. Select Reminder Time dialog

4.  Hear dial tone.

5.  Enter the time (24-hour format) in the Reminder Time field. Use a leading 0 if 
applicable, e.g., 0600 = 6:00 A.M.

The Show Reminder Times dialog appears with a list of all reminders set for the 
extension, as illustrated in Figure 4-9. Show Reminder Times dialog.

Figure 4-9. Show Reminder Times dialog
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To cancel a time reminder:

1.  Select the Reminder option on the Tools menu, and then the Delete Reminder option
to open the Cancel Reminder dialog, as illustrated in Figure 4-10. Cancel Reminder
dialog.

Figure 4-10. Cancel Reminder dialog

2.  Hear dialtone.

3.  Enter the extension to cancel a reminder for in the Extension field. The Select 
Reminder Time dialog opens as illustrated in Figure 4-11. Select Reminder Time 
dialog.
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Figure 4-11. Select Reminder Time dialog

4.  Enter the time (24-hour format) to delete in the Reminder Time field, from the 
reminders displayed in the list, of the reminder to cancel. Use a leading 0 if applicable, 
e.g., 0600 = 6:00 A.M.

The Show Reminder Times dialog displays with the reminder removed, as illustrated in 
Figure 4-12. Show Reminder Times dialog.

Figure 4-12. Show Reminder Times dialog
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To cancel all reminders:

1.  Select the Reminder option on the Tools menu, then the Delete All Reminders option
to open the Cancel All Reminders dialog, as illustrated in Figure 4-13. Cancel All
Reminders dialog.

Figure 4-13. Cancel All Reminders dialog

2.  Hear dialtone.

3.  Enter an extension in the Extension field to cancel all reminders for. 

The Show Reminder Times dialog displays with the message ‘No Reminders’, as 
illustrated in Figure 4-14. Show Reminder Times dialog.

Figure 4-14. Show Reminder Times dialog
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To view reminders for an extension:

1.  Select the Reminder option on the Tools menu, then the View Reminders option to
open the Show Reminders dialog, as illustrated in Figure 4-15. Show Reminders
dialog.

Figure 4-15. Show Reminders dialog

2.  Hear dialtone.

3.  Enter an extension in the Extension field to view all reminders for.

The Show Reminder Times dialog displays with a list of reminders set for the extension, 
as illustrated in Figure 4-16. Show Reminder Times dialog. 

Figure 4-16. Show Reminder Times dialog
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To view all unanswered reminders:

If a reminder that has been set, rings but goes unanswered, as long as an attendant is 
logged in, the Unanswered Reminders field’s icon on the EAWS Status Bar changes from 
blue to red on attendants’ Status Bars. 

To view a list of all reminders that have gone unanswered:

1.  Select the View Unanswered Reminders option on the Tools menu, to open the
Unanswered Reminders dialog, as illustrated in Figure 4-17. Unanswered Reminders
dialog.

Figure 4-17. Unanswered Reminders dialog

2.  Click OK. The dialog closes and the Status Bar Unanswered Reminders icon 
refreshes from red to blue on all attendants’ EAWS Status Bars
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Volume

Whether you are using the PC speakers or a headset (microphone) in the EAWS, you can 
change its volume as follows:

To change the volume level:

1.  Select Options on the Attendant menu.

2.  Select the Audio Controls tab to access the volume controls, as illustrated in Figure 4-
18. Audio Controls.

Figure 4-18. Audio Controls

3.  Slide the volume to the desired level for the Attendant headset or PC speakers.

4.  Make sure the appropriate audio devices appear in the Microphone Device and 
Speaker Device drop-down fields.

5.  Click Save.
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Note  You can test the volume level by entering a checkmark in the Play Sound on Call
Arrival checkbox, then clicking the Volume icon to the right of the System Sound or wav
file fields.
EAWS User Guide



Miscellaneous Procedures - Wakeup Calls 4-25
Wakeup Calls

Teltronics uses the term ‘Reminders’ in the EAWS application, which is synonymous with 
Wakeup Calls in the Hotel industry. For details on using Wakeup Calls (Reminders) see 
the Reminders topic. 
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Keyboard Shortcuts

The following list of Keyboard Shortcuts is available from the EAWS:
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Appendix A
Keyboard Shortcut Function
Dash (-) (Numeric Keypad) Page
Plus Sign (+)  (Numeric Keypad) Recall
Enter (Numeric Keypad) Call
Period (.)  (Numeric Keypad with numlock on) Release
Ctrl + Delete Serial
Ctrl + End Connect
Ctrl + Page Down Select
Page Down Moves down 6 records at a time in 

Directory
Page Up Moves up 6 records at a time in 

Directory
• Ctrl + Up Arrow
• Up Arrow

• Call Queue - Cancel
• Directory - moves up 1 row

• Ctrl + Down Arrow
• Down Arrow

• Call Queue - Call Back
• Directory - moves down 1 row

• Ctrl + Left Arrow
• Left Arrow

• Call Queue - Dial
• Directory - moves 1 char left

• Ctrl + Right Arrow
• Right Arrow

• Call Queue - Split
• Directory - moves 1 char right

• F1
• Ctrl + F1

• online help
• Keyboard Layouts map

• F2
• Ctrl + F2

• Conf
• Barge

F3 Absent
F4 Alarm
F5 Flash
F6 not used
• F7
• Ctrl + F7

• Privacy On
• Privacy Off

F8
Ctrl + F8

Message Lamp On
Message Lamp Off

F9 Voice Mail
F10 Inquire
F11 Identify Busy
F12 Toggle Focus
Ctrl + (0-9) dials Directory Phone entries (0-9)
Ctrl + DTMF Keypad 0 - 9, / for #, and * DTMF digits
Ctrl + M toggle Mute on/off
Ctrl + S opens the Speed Dial List dialog
Alt + (0-9) dials Speed Dial entries (0-9)
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B
Keyboard Layout Map

This appendix shows a graphical map of the EAWS keyboard and each keyboard 
shortcuts function. See the online help (Ctrl + F1) to use the links on this keyboard layout 
to jump to description of keys and a quick description of how to use the most common 
features.
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Index
A
add directory 3-3
adding/removing columns directory 3-7
admin configuration 1-6
Alarms 4-2
alarms 4-2
answer 2-3

B
barge 2-4

C
Call Priority 2-33
call queue 2-1
call waiting 2-7
callback 2-5
calls in queue 2-6
camp on 2-7
cancel 2-8, 2-16
CAS 2-15
class of service 4-4
clear alarms 4-3
Clear Directory 3-18
conference 2-9

2 party 2-9
more than 2 parties 2-9
release 2-10

connect 2-11
COS 4-4
customize directory 3-7

D
default language 1-2
delete directory 3-6
dial directory 3-13
Directory

clear 3-18
directory dial 3-13
directory lookup 3-11

dtmf 2-13

E
edit directory 3-5
execute 2-14
export directory 3-14

F
failure destination 4-5
filters in Directory 3-8
flash 2-15

H
hang up 2-16
hold 2-17

I
Identify Busy 2-20
Inquire 2-22
inquire 3-10

K
keyboard layout map A-1
keyboard shortcuts A-1, A-1

L
language 1-2
log in 1-4
log out 1-5
lookup

directory 3-11

M
make call 2-24
message lamp 4-6–4-7
messages 2-25
modes 2-26



I-2
mute 2-27

O
options 4-8

P
page 2-28
page park 2-30
preview directory 3-15
print directory 3-15

R
rearrange columns in Directory 3-7
recalls 2-33
reminder 4-16

cancel 4-18
cancel all 4-20
view all 4-22

reminders
view 4-21

S
select 2-34
serial calls 2-35
sorting directory columns 3-9
speed dial 2-36

make call 2-41
speed dial list

add 2-37
clear all 2-40
configure 2-37
delete 2-39
edit 2-38
open 2-36

split 2-42

T
toggle focus 2-43, 3-16
transfer 2-44

supervised 2-44

unsupervised 2-44

U
update directory 3-17

V
view alarms 4-3
view directory 3-5
voice mail 2-45
Volume 4-23

W
Wakeup Calls 4-25
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